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Microsoft Excel 2013: Part 4  
Introduction to Formulas & 

Excel Functions 

 

 
 

Introduction to Formulas:  

Just like a calculator, Excel has the ability to calculate numerical information using formulas. Excel can 

add, subtract, multiply, and divide. In this lesson, we'll show you how to use cell references to create 

simple formulas. 

Note:  All formulas start with the ‘=’ equal sign.  This is because the cell contains, or is equal to, the 

formula and the value it calculates. 

 

Addition + =10+5

Substraction - =10-5

Multiplication * =10*5

Division / =10/5  
 

Understanding Cell Reference: 

As shown in the table above, you can simply create formulas manually by typing in fixed numbers to 

get calculation.  However, most of the time, you will use cell addresses to create a formula. This is 

known as making a cell reference. Cell reference identify individual cells, rows, and/or columns in a 

worksheet.  They tell Excel where to look for values to use in a formula.  Using cell references will 

ensure that your formulas are always accurate because you can change the value of referenced cells 

without having to rewrite the formula. 

 

To practice, open up a new workbook.  Enter 10 in Cell A1 and 5 in Cell A2.  Instead of typing in =10+5 

to get the result in Cell A3, you can use Cell addresses to get the same result.  See the formula entered 

into Cell A3 (Figure 1) displays the answer to the equation =A1+A2 in Figure 2.  If any value in those 

referenced cells (A1 or A2) changes – such as changing the value in Cell A1 to 20, the result cell A3 will 

automatically recalculates for you as shown in Figure 3.  

 

 

 

 

 

 

 Figure 1     Figure 2    Figure 3 
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By combining a mathematical operator with cell references, you can create a variety of simple 

formulas in Excel. Formulas can also include a combination of cell references and numbers, as in the 

examples below: 

 

=F2-1 Subtract 1 from Cell F2 

=G2/F2 Divide Cell G2 by Cell F2 

=F2*1.5 Multiply Cell F2 by 1.5 

 

Other Examples on Cell References: 

 

Cell references Refer to values in 

A10 the cell in column A and row 10 

A10,A20 cell A10 and cell A20 

A10:A20 the range of cells in column A and rows 10 through 20 

B15:E15 the range of cells in row 15 and columns B through E 

A10:E20 the range of cells in columns A through E and rows 10 through 20 

 

To Create a Formula Using the Point-and-Click Method: 

Rather than typing cell addresses manually, you can point and click on the cells you wish to include in 

your formula. This method can save a lot of time and effort when creating formulas.   

 

Exercise:  Use FormulaSample worksheet from ExcelPart4.xlsx workbook to follow the steps below.  

We are going to calculate the Total Cost for each line item by multiplying the Units and Unit Cost.  

 Select Cell G2. 

 Type in the equal sign “=”. 

 Click on Cell E2; the cell address will appear in the formula, and a dashed blue line will appear 

around the referenced cell. 

 Type the mathematical operator you wish to use. In our example, we'll type the multiplication 

sign (*). 

 Then click on Cell F2; the cell address will appear in the formula, and a dashed red line will 

appear around the referenced cell. 

 

 

 

 

 

 

 
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 Press Enter on your keyboard. The formula will be calculated, and the value will be displayed 

in the cell. 

 
 

Formulas can also be copied to adjacent cells with the fill handle , which can save a lot 

of time and effort if you need to perform the same calculation multiple times in a worksheet. To utilize 

this useful feature, follow these steps. 

 Click on Cell G2 where we entered our formula first. 

 Click; hold and drag the Fill Handle to copy the functions to adjacent cells.  

 
 

To Edit a Formula: 

When you need to edit an existing formula, you can do so in a number of ways.  Let’s assume we are 

going to edit our formula in Cell G2 to include the markup of 10%.  That would require to multiply the 

original formula =E2*G2 with 1.1 as =E2*G2*1.1.  To do this, follow these steps. 

 Double-click on Cell G2 where we entered our original formula.  The cursor should be blinking at 

the end of the existing formula. (If not, move your cursor to the end of the existing formula.)    

  

 Then type in the multiplication symbol “*” and “1.1” as shown.   

OR 
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 You can also click directly in the formula bar area to fix the formula. When finished, hit Enter key 

on your keyboard or select the Enter command  in the formula bar. 

 

 In either case the calculated value will show in Cell G2.             

Use the Fill Handle feature to copy the new formula to the rows below. Keep this book opened. 

Note: To learn more about “order of operations” to use in complex formulas, please see Appendix. 

 

Relative and Absolute Cell References: 

There are two types of cell references: relative and absolute. Relative and absolute references behave 

differently when copied and filled to other cells. Relative references change when a formula is copied 

to another cell. Absolute references, on the other hand, remain constant, no matter where they are 

copied. 

 

Relative Cell References:  By default, all cell references are relative references. When copied across 

multiple cells, they change based on the relative position of rows and columns. For example, if you 

copy the formula =A1+B1 from row 1 to row 2, the formula will become =A2+B2. Relative references 

are especially convenient whenever you need to repeat the same calculation across multiple rows or 

columns. Let’s verify this by looking at our example Formulasample.xlsx we just practiced on page 10 

above. 

 The formula in Cell G2 is the product of Cell E2 and Cell F2.  =E2*F2 

   
 When we copied this formula to the lower Cell G3 by using the Fill Handle, the cell reference 

changed based on the relative position of the row – in this case, Row 3.  So, the copied formula 

becomes =E3*F3 

 
 If you check the remaining cell formulas in Cell G4 through G44, the cell references in these 

cells change to the relative position of their row numbers.  
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$A$2 the column and the row do not change when copied

$A2 The colum does not change when copied

A$2 The row does not change when copied

 

Absolute Cell Reference: 

There may be times when you do not want a cell reference to change when filling cells. Unlike relative 

references, absolute references do not change when copied or filled. When you want to keep a row 

and/or column constant, use an absolute reference. 

 

An absolute reference is designated in a formula by the addition of a dollar sign ($). It can precede the 

column reference, the row reference, or both.  See the examples, below. 

 

Use generally more than 

 other two formats. 

 

 

 

 

When writing a formula, select the cell you want to change and press the F4 key on your keyboard to 

switch between relative and absolute cell references. This is an easy way to quickly insert an absolute 

reference.  Let’s do the exercise below. 

 

Exercise:  Open the MenuOrder worksheet in the same workbook.  In this example, 8.0% sales tax rate 

in Cell E2 to calculate the sales tax for all items in column D.  That requires us to use the absolute cell 

reference $E$2 in our formula. Since each formula is using the same tax rate, we want that reference 

to remain constant when the formula is copied and filled to other cells in column D.  Follow the steps 

below. 

 

 Select the cell that will contain the formula. In our example, we'll select cell D4. 

 Enter the formula to calculate the desired value. In our example, we'll type =(B4*C4)* E2 

 

 After entering cell address E2, hit function key F4 on your keyboard.  The relative cell 

reference E2 will change to an absolute cell reference as $E$2.   

 Press Enter on your keyboard. The formula will calculate, and the result will display in the cell. 

 Locate the fill handle in the lower-right corner of the desired cell D4.  
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 Click, hold, and drag the fill handle over the cells you wish to fill: cells D4:D14. 

 
 Release the mouse. The formula will be copied to the selected cells with an absolute 

reference, and the values will be calculated in each cell.  See below. 

 
 You can double-click the filled cells to check their formulas for accuracy. The absolute 

reference should be the same for each cell, while the other references are relative to the cell's 

row. 
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To reference cells across worksheets or Link Data across worksheets: 

Excel allows you to refer to any cell on any worksheet, which can be especially helpful if you want to 

reference a specific value from one worksheet to another. To do this, you'll simply need to begin the 

cell reference on the worksheet you want to see the result.  Let’s use the same workbook above to 

practice.   

 Since we have calculated sales tax for all the cells in column D, copy the formula in Cell E4 

=B4*C4+D4 onto Cell E5 through E14 by using the Fill Handle.  See the result below. 

 
 Now, the total value shows in Cell E15 of this Menu Order worksheet.  We will reference this 

cell to another worksheet Catering Invoice worksheet in the same workbook. 

 Navigate to the Catering Invoice worksheet where we want to see the result appeared. Locate 

and select the cell B3 where you want the value to appear. 

 Type the equals sign (=); then click the worksheet where the reference cell exists.  In our 

example, Menu Order worksheet; then select Cell E15.   
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 The formula appears as ='Menu Order'!E15 in the formula bar area.    See below. 

 
 

 Press Enter on your keyboard. The value of the referenced cell will appear. 

  
 

 If the value of cell E15 changes on the Menu Order worksheet, it will be updated automatically 

on the Catering Invoice worksheet.  To test this, change the quantity in Cell C14 from 10 to 20.  

The total in Cell E15 changed to $655.07. 
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 The referenced cell in Catering Invoice worksheet ,cell B3, gets automatically updated.  

 

Note:  If you rename your worksheet at a later point, the cell reference will be updated automatically 

to reflect the new worksheet name.  Try changing the worksheet name Menu Order into Menu.  The 

cell reference is automatically to reflect the new worksheet name as =Menu!E15  

 

To reference cells across workbooks or External Data Link across workbooks: 

The same principal of creating cell reference across worksheets in the same workbook also applies to 

creating external references across different workbooks.  External references are especially useful 

when it is not practical to keep large worksheet together in the same workbook.  By doing so you can 

merge data from several workbooks and integrate them into a summary workbook.  

 

Let’s use the same workbook above to practice further on this concept.  Assume you have two more 

cells in the Catering Invoice worksheet for Paper Items and Rental Equipment.  And you have two 

separate workbooks for each item called PaperItems.xlsx and RentalEquipments.xlsx. 

 



Copyright © 2014 ASCPL All Rights Reserved Page 10 of 19 MS2013-ExcelPart4 MMS 1/14/2015 

 Open those two workbooks (PaperItems.xlsx and RentalEquipments.xlsx) and leave them 

open.  

 Let’s start referencing for Paper Items Cell – Cell B4. In your ExcelPart4.xlsx workbook, click in 

Cell B4 on Catering Invoice worksheet.  Type in equal “=” sign. 

 Then navigate to PaperItems.xlsx workbook and click on Cell E8 where the total figure for 

Paper Items is.  You can see that the external reference includes the workbook name in square 

brackets ([ ]), followed by the worksheet name, an exclamation point (!), and the cells that the 

formula depends on.  Notice the cell address is an absolute. 

 Hit Enter button and you 

will be navigated to the 

ExcelPart4.xlsx workbook 

where cell referencing 

begins. 

 Do the same to fill in 

Rental Equipment cost line 

in cell B5.  Make sure to 

reference to cell E7 in 

RentalEquipments.xlsx. 

 

 

 

Note:  If any of the data changes in either source workbooks - Paperitems.xlsx or RentalEquipments.xlsx, 

the referenced cells in the destination workbook – ExcelPart4.xlsx will be automatically updated.  If all 

these workbooks are open simultaneously, the updates will happen instantly without any notification.  In 

reality, the updates on the source workbooks could and would have been carried out without the 

destination workbook opened.  If that is the situation, when the destination workbook – ExelPart4.xlsx is 

open by itself, you will see the Security Warning above the formula bar area as shown below. 

 

 
 

Click on Enable Content button.  The Security Warning dialog box will appear to give you option whether 

you want to mark the linked source workbook(s) as Trusted Document(s) or not.  If you say “No”, you will 

have to click on the Enable Content button every time you open the destination workbook – 

ExcelPart4.xlsx by itself.  Say “Yes” if you want to skip that step and the warning will not be there anymore. 
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When you open the destination next time, you will receive the dialog box below.  Click on Update if you 

want to open the workbook with updated data; otherwise, click on Don’t Update button. 

 

 
 

Introduction to Functions: 

A Function is a predefined formula that performs calculations using specific 

values in a particular order. Excel includes many common functions under the 

Home tab that can be useful for quickly finding the sum, average, count, 

maximum value, and minimum value for a range of cells.  Let’s examine the 

different parts of a sum function and how to create arguments to calculate 

values and cell references.   

 =   Sum  (A10:A20) 

                   

Equation     Function   Argument 

 

Equation: is required at beginning of every formula. 

Function: is a predefined formula; in this example, to sum or add what is stated in the argument. 

Argument: contains the information you want to calculate and it must be enclosed within a parenthesis.   

It can refer to both individual cells and cell ranges, in this example, referring to cell range A10 through 

A20.  You can include one argument or multiple arguments, depending on the syntax required for the 

function.  
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Basic Mathematical Functions 

AVERAGE Finds the average within a range of cells. =AVERAGE(A10:A20) 

COUNT 
Finds the number of cells within a range of cells that 

contain values (numbers) in them. 
=COUNT(A10:A20) 

COUNTA 

The COUNTA function counts cells containing any type 

of information, including error values and empty text 

(""). For example, if the range contains a formula that 

returns an empty string, the COUNTA function counts 

that value. The COUNTA function does not count 

empty cells.  

=COUNTA(A3:A15) 

COUNTBLANK Counts empty cells in a specified range of cells. =COUNTBLANK(B3:B15) 

MAXIMUM Finds the largest number within a range of cells. =MAX(D3:D15) 

MINIMUM Finds the smallest number within a range of cells. =MIN(D3:D15) 

SUM Finds the total or sum within a range of cells. =SUM(A10:A20) 

Basic Date Functions 

NOW() 

Displays the computer’s current date and time.  The 

formula will update the date and time next time the 

workbook is opened. 

=NOW() 

TODAY() 
Displays the computer’s current date.  The formula will 

update the date next time the workbook is opened. 
=TODAY() 

Creating Basic Functions: 

Single Argument Exercise:  Open ExcelFunctions.xlsx to practice creating arguments. 

Average Function: 

 In Cell C17 we want to calculate the average price per unit.  Select Cell 

C17. 

 Click on the drop-down arrow next to the Sum function in the Editing 

Group under the Home tab.  Select Average. 

 
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 The selected function will appear in the cell. If logically placed, the Average command will 

automatically select a cell range for the argument. In our example, cells C3:C16 were selected 

automatically.  In our case, there is no data in C16.  You can manually fix the argument directly 

in the formula bar area by using the backspace button on your keyboard and change the cell 

address from C16 to C15. 

  
(OR you can use your mouse; 

click and drag to include the 

desired cell range into the 

argument as well.) 

 Press Enter on your keyboard. 

The function will be calculated, 

and the result will appear in the 

cell. In our example, the average 

of C3:C15 is $13.72. 

 Find the “Average Shipping Time 

(Days)” in Cell B24 by using the 

same Average function for the 

cell range G3:G15. OR you can 

use your mouse; click and drag to 

include the desired cell range 

into the argument. The result: 

3.7692308.  Adjust the decimal 

point to show only 2.  The result 

should be 3.77. 

 

Sum Function: 

 Click on Cell D18. 

 Select the Sum function from the list. 

 Fix the cell range by using the mouse (start from cell D3 and drag your mouse to D15 to 

include the cell range D3:D15. 

 Hit Enter.  The sum of Total Cost in our example is: $878.16. 

 Use the same Sum function to get total “quantity of items ordered” (cell B3:B15) in cell B16. 

Result: 78. 

Maximum Function: Find out the most expensive item in column C (Price Per Unit) in cell B23 by using 

the =MAX(C3:C15).  The result should be: $28.69. 

 

Multiple Argument Example:  A function can 

contain multiple arguments.  Each argument has 

to be separated by the “comma”. For example, 

the function =SUM(A1:A3, C1:C2, E2) will add the 

values of all the cells in the three arguments.  

(Example: GCFLearnFree.org) 
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Complex Function/Formula: 

There are hundreds of functions in Excel and 

you can search them by category, such as 

Financial, Logical, Text, Date & Time, and 

more from the Function Library on the 

Formulas tab.  The ones you use most 

frequently will depend on the type of data 

your workbooks contains. To access the Function Library, select the Formulas tab on the Ribbon. The 

Function Library will appear.  Click on each category to explore some of the different types of functions 

that will be helpful as you create new projects. 

 

For complex formulas, it’s not easy to remember which function and which arguments to use for each 

task. Fortunately, the Insert Function feature in Excel helps you with this.  We will use the same example 

above to count the number of cells to get the answer “how many items are ordered in column A”.  Since 

the items in column A are in text, we cannot use the basic COUNT function because it will only count cells 

with numerical information. We will have to use the COUNTA function.  We will enter the answer in cell 

C22.  Follow the steps below. 

 Select a cell C22. 

 Click on Insert Function command in the formula bar area   OR  

select Formulas tab and click on Insert Function command in the Function Library group.   

 Insert Function dialog box will open; type 

“count cells” in the Search for a function 

box and click on Go button.  

Recommended functions will appear in 

the “Select a function” box.  By clicking on 

each, the explanation of that function will 

appear in the lower part of the box. 

 

 

 
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 When COUNTA shows up in the Selection a 

function box, click on it.  Click on OK button.  

 

 Function Arguments dialog box will come up. 

Change the Value1 to include cell range 

A3:A15.  You may continue to add arguments 

in the Value2: field if you have more cells to 

count, but in this case we only want to count 

the number of cells in the cell range A3:A15. 

 

 Click on OK.  The result should be 13. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note:  You can type in any search term in the Search for a Function box and the recommended 

function will be provided.  These dialog boxes include explanation on what each function does 

such as in our example, .   

 

If you need any additional explanation on any function, you may click the link on “Help on this 

function” in these dialog boxes. Excel Help window will open to provide you with the detailed help 

with examples.    
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Display Formulas on your worksheet: 

You can display the formulas in your worksheet by 

using the Show Formulas command in the Formula 

Auditing group under the Formulas tab.  

 

 

 

 
 

If you want to have the row numbers 

(1,2,3..) and column headings (A,B,C..) 

in your print out, go to Page 

Layout>Page Setup>Click on Sheet 

tab>Check on Row and column 

headings box.  Keep this workbook 

open for next topic.  
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Trace Precedents and Dependents: 

Sometimes, checking formulas for accuracy or finding the 

source of an error can be difficult when the formula uses 

precedent or dependent cells.  For practice, let’s use the 

same workbook. 

 

Trace Precedents shows arrows that indicate which cells affect the value of the currently selected cell. 

In our example, if you want to check which are the values that affect the value in cell “D3”. This is 

where “Trace Precedents” help. Select D3. Go to the Formula tab and select Trace 

Precedents.

 
You will now magically see arrows (as above) which means the value in D3 is dependent on values 

coming from multiple cells “B3” and “C3” in our example, i.e. Total Cost=Quantity*Price Per Unit.  

 

Trace Dependents does exactly the opposite. This option shows which are the cells affected by values 

from this cell. In our example let’s take a look at cell “C3”.   

 Click cell C3 and then on 

Trace Dependents. You 

will see multiple arrows to 

indicate cells D3, B23 and 

C17 are depending on the 

value in cell C3. 

 Click Trace Dependents 

again since it runs the 

dependency in recursion, 

and another arrow 

pointing to cell D18 to 

indicate the value in cell 

D18 is also depending on 

the value in cell C3.  

So if the value in cell C3 changes, 

all of these cells will be affected.   

To remove the arrows, use the 

“Remove Arrows” button from 

“Formulas” toolbar. 
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Appendix: 

 “Order of Operations” to more complex mathematical expressions: 

A complex mathematical expression has more than one mathematical operator, such as 5+2*8. When 

there is more than one operation in a formula, the order of operations tells Excel which operation to 

calculate first. In order to use Excel to calculate complex formulas, you will need to understand the 

order of operations as follows: 

 

Excel calculates formulas based on the following order of operations: 

 

1. Operations enclosed in parentheses 

2. Exponential calculations (3^2, for example) 

3. Multiplication and division, whichever comes first 

4. Addition and subtraction, whichever comes first 

A mnemonic that can help you remember the order is PEMDAS, or Please Excuse My Dear Aunt Sally. 

 

So in this following example to solve - 10+(6-3)/2^2*4-1, the order of operations will be carried out 

according to the order stated above. See the steps below. 

Step 1) 

    
Step 2) 

    
Step 3) 
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Step 4)  

  
Step 5)  

  
Step 6) 

  
Step 7) 

 
 

Exercise:  Open the CateringInvoice.xlsx workbook and calculate 7.5% Tax in Cell D6.   

 Steps: Add Cell D3, D4, and D5 in the Parenthesis; Multiply the result with .075 such as 

=(D3+D4+D5)*.075.   

 Then calculate the total in Cell D7 by adding Cells D3 through D6 by using point and click 

method. 


